
JobGen｠Plus｠JobGen｠Plus｠JobGen｠Plus｠JobGen｠Plus｠の学習の学習の学習の学習｠｠｠｠

本書では以下を学習します:

• 簡単な JobGen｠Plus アプリケーションの作成方法｠

• C 言語で複雑な JobGen｠Plus｠アプリケーションを作成する方法｠｠
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第第第第 1111 章章章章｠｠｠｠｠｠｠｠簡単な簡単な簡単な簡単な｠JobGen｠Plus｠｠JobGen｠Plus｠｠JobGen｠Plus｠｠JobGen｠Plus｠アプリケーションアプリケーションアプリケーションアプリケーション｠｠｠｠

｠｠｠｠資産管理資産管理資産管理資産管理｠｠｠｠

このアプリケーションは各地にある現在の資産情報の収集を行うために設計されました。
それぞれの資産は資産番号で表されます。ユーザはこのアプリケーションの入ったポー
タブル・データコレクタを持って各地にある資産番号を収集します。ユーザがこの
JobGen Plusアプリケーションを設計する前に以下を決定する必要があります。

データのタイプ ポータブル・データコレクタの各データファイルは、複数のデータ
レコードで構成されています。各データレコードは同じデータフィールド
の番号を含んでいます。二つのデータフィールドが資産管理の場所と資産
番号に必要です。ユーザは各データフィールドのデータタイプを決めなけ
ればなりません。

プロセス ユーザは実行するために必要なプロセスの概略をまとめなければなりませ
ん。資産管理のアプリケーションは 5つの別なプロセスが必要です。

1. 場所の情報を収集する。

2. 場所の情報を検証する。

3. 資産番号を収集する。

4. 資産番号を検証する。

5. データを編集する。

作業のフロー 資産管理の作業は以下の方法で行われます。

1. 場所の情報を収集します。あるいはポータブルターミナルに収集され
たデータを編集する場合は ”F2”キーを押します。

2. 場所の情報を検証します。

3. 場所の情報が指定された要求をパスした場合、ステップ 4 へ進みます。
そうでなければステップ 1に進みます。

4. 資産番号を収集します。

5. “F1”キーを押した場合、ステップ 1へ進みます。そうでなければステ
ップ 6へ進みます。このステップは新しい場所の情報を入力するため
に”F1”キーを押すことができます。
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6. 資産番号を検証します。

7. 資産番号が指定した要求をパスした場合、ステップ 4へ進みます。こ
のサンプルでは、それ以外もステップ 4へ進みます。

資産管理の作成資産管理の作成資産管理の作成資産管理の作成

上記のリストに従って、資産管理のアプリケーションは二つのデータフィールドについ
て二つの収集(collect)ノード、そして収集したデータの表示と編集のために編集(Edit)ノ
ードが必要です。また、いくつかのリンクがノード間の移動を実現するために必要で
す。以下のステップは資産管理のアプリケーションをどのようにして作成するかを示し
ています。

ヒントヒントヒントヒント:日本語メニューを作成する場合は、上記の作業をする前に Editメニューから
Define Portableを選択し、Setting > Screen > Large Fontをチェックして下さい。

1. マウスポインタを Collectノード ボタン に移動して下さい。マウスポインタが

Collectノード ボタン 上にある時に左マウスボタンをクリックして下さい。そし
てマウスポインタを Collectノード が置かれる場所に移動して下さい。
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左マウスボタンをダブルクリックして下さい。
あるいは、ノードを置きたい場所で右クリックすると、コンテキストメニューがポ
ップアップします。作成するために Collectノードを選択して下さい。
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マウスボタンが Collectノード にある間に左マウスボタンをダブルクリックして下
さい。 “Define Node [Collect]”ウインドウがスクリーンに現れます。

以下のオプションを変更します。

(a) Basicプロパティで、 “collect1”から “Location”に名前を変更します。

(b) Start Nodeをチェックします。このノードは資産管理アプリケーションの始ま
りをマークします。

(c) Screen > positionプロパティで、“Clear Screen From Specified Location To The
End Of Screen”(指定した場所からスクリーンの最後までをクリアする指定した場所からスクリーンの最後までをクリアする指定した場所からスクリーンの最後までをクリアする指定した場所からスクリーンの最後までをクリアする)オプシ
ョンを選択し、 “0” と “0” を row (行)と column(列)のボックスにタイプします。
このオプションはターゲットデバイスのスクリーンを行 0 /列 0から最後の行/
列まですべてクリアします。
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(d) “At Specified Location”オプションを選択して、Rowと Columnのボックス
に”1”と”0”をタイプします。このオプションは行 1と列 0の位置から入力デー
タ(ユーザによって入力される)を表示します。

2. Screenプロパティを選択します。スクリーンのスペースに “所在地:”をタイプしま
す。
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3. Inputプロパティを選択して下さい。 “Define Collect”ウインドウは以下のように変
わります。

4. “Set Data As Same As Last Record, And Complete Input”をチェックします。これは
“所在地”情報を一回だけ入力すればようようにし、そして”F1”キーを押すまで”資
産番号”の入力を続けます。

5. Verifyプロパティを選択して下さい。 “Define Collect”ウインドウは以下のように変
わります:
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6. OKをクリックして下さい。

次のステップは二番目の Collectノードを作ります。

7. マウスカーソルを Collectノードを置く場所に移動します。左マウスボタンをダブ
ルクリックします。
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8. マウスポインタが新しく作った Collectノード にある間に左マウスボタンをダブル
クリックして下さい。 “Define Collect”ウインドウがスクリーンに現れます。

9.以下のオプションを変更します:

(a) “collect2”の名前を “Asset_Number”に変更します。

(b) Screen > Positionプロパティで、 “Clear Screen From Specified Location To The
End Of Screen”を選択して、 “1”と “0”を入力します。このオプションはター
ゲットデバイスのスクリーンを行 1 /列 0から最後の行と欄まですべてクリア
します。

(c) “At Specified Location”を選択して、 “1”と “0”をタイプします。このオプシ
ョンは、行 1と列 0の位置から入力データ(ユーザ入力データ)を表示します。

(d) Input > Initial Valueのチェックは両方とも付けません。

10. Screenプロパティを選択します。 “Define collect”ウインドウは以下のように変わり
ます。スクリーンのスペースに “資産#入力:”をタイプして下さい。
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11. OKをクリックして下さい。
次のステップは Editノード を作ります。

12.マウスポインタを Editノードボタン に移動します。マウスポインタが Editノー

ドボタン にある間に左マウスボタンをクリックします。次に、マウスポインタ
を Editノードを置く場所に移動します。
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左マウスボタンをダブルクリックします。

13.マウスポインタが Editノードにある間に左マウスボタンをダブルクリックします。
“Define Edit”ウインドウがスクリーンに現れます。
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14.以下のオプションを変更します。

(a) 名前を “Edit3”から “Edit”に変更します。

(b) Data File Nameオプションとして ASSETMGT.TXTをタイプします。

(c) Field Separatorについて“, [Comma]”を選択します。

15. OKをクリックします。

次のステップは最初の Collectノード から二番目の Collectノード へのリンク を作
ります。

16.マウスポインタをリンクボタン に移動します。マウスポインタがリンクボタン
にある間に左マウスボタンをクリックします。そしてマウスポインタを “Location”
ノード に移動します。左マウスボタンをクリックしたままにします。マウスポイン
タを “Asset_Number”ノードに移動し、左マウスボタンを離します。

17.マウスポインタを新しい作成したリンクに移動し、そして、このリンクについて
の情報が現れます。リンクの標準設定は “On Always”です。これは “Location”ノー
ド がデータ収集を終了したら、 “Asset_Number” ノード に進むことを示しています。
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18.次のステップは “Asset_Number”ノードから “Location”ノードへの別なリンクを作
ります。

19.マウスポインタを “Asset_Number”ノードに移動します。左マウスボタンをクリッ
クしたままにします。マウスポインタを “Location”ノードに移動し、左マウスボタ
ンを離します。

20.新しく作ったリンク上にマウスポインタがある間に左のマウスボタンをダブルクリ
ックします。 “Define Node”ウインドウがスクリーンに現れます。

21.以下のオプションを変更します。

(a) Keypad Inputをチェックします。 そしてマウスを空白の行に移動し、左マウ
スボタンをクリックします。 “PT-600 Keypad”ウインドウがスクリーンに現れ
ます。
マウスポインタを F1キーに移動し、左マウスボタンをクリックします。OK
をクリックします。この選択はユーザがポータブル・データコレクタで”F1”キ
ーを押した場合、 “Location” ノード が直ちに処理されることを示しています。
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(b) “RRLI, Reset ‘Repeat Last Input’ For All Nodes”をチェックして下さい。この
選択は“Location”ノードの “Set Data As Same As Last Record, And Complete
Input”オプションに関係します。RRLIがチェックされているこのリンクがア
クティブになったら、 “Location”ノードは新しいデータをユーザが入力する必
要があります。

22. OKをクリックします。
次のステップは、最初の Collectノードから Editノードへのリンクを作成します。

23.マウスポインタを “Location”ノードに移動します。 左マウスボタンをクリックし
たままにします。マウスポインタを “Edit”ノードに移動し、左マウスボタンを離し
ます。

24.マウスポインタを新しく作成したリンクに移動し、そしてこのリンクについての情
報がスクリーンに現れます。
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25.以下のオプションを変更します:

(a) Keypad Inputをチェックします。そしてマウスを空白の行に移動して左マウ
スボタンをクリックします。“PT-600 Keypad”ウインドウがスクリーンに現れ
ます (前のリンクと全く同じ)。

(b)カーソルポインタを F2キーへ移動して、左マウスボタンをクリックします。
OKをクリックします。この選択はユーザがポータブル・データコレクタ
の”F2”キーを押した場合、 “Edit”ノードが直ちに処理されます。次のステップ
は Editノードから最初の Collectノードへのリンクを作ります。

26.マウスポインタを “Edit”ノードへ移動します。左マウスボタンをクリックしたま
まにします。マウスポインタを“Location”ノードへ移動して、左のマウスボタンを
離します。
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27.マウスポインタを新しく作成したリンクに移動し、そしてこのリンクについての
情報がスクリーンに現れます。 リンクの標準設定は “On Always”です。 これは
“Edit”ノードが終わった場合、 “Location” ノード が処理されることを示しています。

アプリケーションを終了する前に、ジョブはまず保存されなければなりません。マ
ウスポインタをメニューバーの Build > Make Jobに移動します。マウスポインタが
Make Jobにある間に左マウスボタンをクリックします。そしてマウスポインタを
File > Save As...に移動して、左マウスボタンをクリックします。

28. ジョブ のファイル名として、File Name スペース中に“assetmgt.job” を 入力します。
OKをクリックします。
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ジョブを保存した後、最後のステップはデータレコードの最後をマークする最後の
リンクを別にすることです。

29.新しいリンクの相手先として “Asset_Number”ノードを選択するループしたリンク
を作成します。ノードメニューでリンクを選択するか、ツールバーのリンクアイコ
ン をクリックします。マウスポインタを “Asset_Number”ノードに移動して、左
マウスボタンをクリックしたまま、ノードの中を少し動かして左マウスボタンを離
します。

はいをクリックします。

30. Edit > New Recordで新しいレコードを作成し、次に Edit > Define Recordでレコード
を定義します。
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Record Name:を ASSETMGTとします。

Data Nodeの Asset_Numberと Locationを移すために、>>キーを使用します。

OKを押します。
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31.作成したリンク上をダブルクリックします。

EORをチェックします。この動作は “Asset_Number”がそのデータ収集を終了した
後で、データレコードの収集も終了します。

32. Verify Node’s Statusをチェックし、Pass Alwaysオプションを選択します。

これにより、F1キーが押されるまでは、資産番号の収集を続けます。

33. OKをクリックし、ジョブを再度保存します。

34.ジョブを保存した後で、マウスのポインタをツールバーのMake JoBボタンに置き
ます。資産管理のジョブをコンパイルするために左マウスボタンをクリックします。
これにより実行可能な形式ファイル作成のプロセスをスタートします。
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EXEファイルを作った後で、 JobGen Plusはポータブルターミナルにジョブの実行形式
をダウンロードし、実行の準備ができました。

35.ポータブルターミナルを起動して、本プログラムを実行して下さい。

所在地情報を入力した後、F1キーを押すまで資産番号の入力が続きます。
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第第第第 2222 章章章章｠｠｠｠｠｠｠｠複雑な複雑な複雑な複雑な｠JobGen｠Plus｠｠JobGen｠Plus｠｠JobGen｠Plus｠｠JobGen｠Plus｠アプリケーションアプリケーションアプリケーションアプリケーション｠｠｠｠

在庫管理在庫管理在庫管理在庫管理｠｠｠｠

このアプリケーションは、現在の在庫情報を収集します。

在庫情報は三つの種類、部品番号のみ、部品番号と数量、そして部品番号とシリアル番
号に分けることができます。このジョブを設計する前に、ユーザはこれらの基本的な要
求のノートを作る必要があります:

データタイプ ポータブル・データコレクタの各データファイルは複数のデータレ
コードで作られています。三つのデータフィールド、 Part Number(部品番
号), Quantity(数量)、 Serial Number(シリアル番号)がこのジョブに必要です。
ユーザは各データフィールドについてデータタイプ(文字列または整数)を
決めなければなりません。このジョブは三つの違った情報タイプを含んで
いるので、データレコードの内容は異なっています。部品番号だけの在庫
情報については、Quantityフィールドと Serial Numberフィールドは “0”に
セットされます。部品番号と数量のある在庫情報については、 Serial
Numberフィールドは “0”にセットされます。部品番号とシリアル番号を
持つ在庫情報については Quantityフィールドは “1”にセットされます。

プロセス ユーザは実行する必要のあるプロセスをまとめなければなりません。この
ジョブは 15のプロセスを必要としています:

1. 在庫情報のタイプを選択

2. 部品番号を収集

3. 部品番号を検証

4. 数量のフィールドを 0にセット (選択したタイプが部品番号のみの場
合)

5. 数量のフィールドを 1にセット (選択したタイプが部品番号とシリア
ル番号の場合)

6. シリアル番号フィールドを 0にセット (選択したタイプが部品番号の
みか、部品番号と数量の場合)

7. 数量を収集 (選択したタイプが部品番号と数量の場合)

8. 数量を検証 (選択したタイプが部品番号と数量の場合)

9. シリアル番号がバラバラか、連続かを選択 (選択したタイプが部品番
号とシリアル番号の場合)



24

10.シリアル番号を収集 (選択したタイプが部品番号とシリアル番号の場
合)

11.シリアル番号を検証 (選択したタイプが部品番号とシリアル番号の場
合)

12.最初のシリアル番号を収集 (選択したタイプが部品番号とシリアル番
号で、シリアル番号が連続の場合)

13.最初のシリアル番号を検証 (選択したタイプが部品番号とシリアル番
号で、シリアル番号が連続の場合)

14.在庫の全数量を収集 (選択したタイプが部品番号とシリアル番号、シ
リアル番号は連続の場合)

15.連続したシリアル番号を自動的にデータファイルに書き込む (選択し
たタイプが部品番号とシリアル番号、シリアル番号は連続の場合)

在庫管理の作業フローは以下の方法で行われます:

1. ユーザは情報のタイプを選択します:

(a) 部品番号のみ

(b) 部品番号と数量

(c) 部品番号とシリアル番号

2. (a) を選択した場合、次のステップに進みます。 (b) を選択した場合、
ステップ 7に進みます。(c)を選択した場合、ステップ 13に進みます。

3. 部品番号(Part Number)情報の収集

4. ユーザが “Exit”キー (CMD -> ESC)を押したら、ステップ 1に進みま
す。

5. 部品番号情報を検証します。入力データが検証をパスしなかった場合、
ステップ 3へ進み、それ以外は次のステップへ進みます。

6. 数量(Quantity)フィールドとシリアル番号(Serial Number)の両方のフ
ィールドに “0”をセットします。次の入力のためにステップ 3へ進み
ます。

7. 部品番号(Part Number)情報を収集します。

8. “Exit”キー(CMD -> ESC)が押されたら、ステップ 1へ進みます。

9. 部品番号情報を検証します。入力データが検証をパスしなかった場合、
ステップ 7へ進みます。それ以外は、次のステップへ進みます。

10.数量(Quantity)情報を収集します。
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11.数量(Quantity)情報を検証します。入力データが検証をパスしなかっ
た場合、ステップ 11に進みます。それ以外は、次のステップへ進み
ます。

12.シリアル番号(Serial Number)フィールドに”0”を入れます。ステップ
7に進みます。

13.部品番号(Part Number)情報を収集します。

14. “Exit”キー (CMD -> ESC)が押された場合、ステップ 1に進みます。

15.部品番号(Part Number)情報を検証します。入力データが検証をパス
しなかった場合、ステップ 13に進みます。それ以外は、次のステッ
プに進みます。

16.シリアル番号が連続か、連続でないかを選択します。

17.シリアル番号が連続の場合、次のステップに進みます。それ以外は、
ステップ 25に進みます。

18.最初のシリアル番号を収集します。

19.シリアル番号(Serial Number)情報を検証します。入力データが検証を
パスしなかった場合、ステップ 18に進みます。それ以外は、次のス
テップに進みます。

20.連続する項目の番号を収集します。

21.番号を検証します。入力データが検証をパスしなかった場合、ステッ
プ 20に進みます。それ以外は、次のステップに進みます。

22.カウンタをゼロにセットします。

23.数量(Quantity)フィールドに”1”を入れ、データファイルに連続シリ
アル番号(Serial Number)を追加します。

24.カウンタに 1を加えます。カウンタは連続する項目番号に等しい場合、
ステップ 13に進みます。それ以外はステップ 23に進みます。

25.シリアル番号を収集します。

26.シリアル番号情報(Serial Number)情報を検証します。入力データが検
証をパスしなかった場合、ステップ 25に進みます。それ以外は次の
ステップに進みます。

27.数量(Quantity) フィールドに “1” を入れます。ステップ 13に進みます。
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在庫管理の作成在庫管理の作成在庫管理の作成在庫管理の作成

複雑なので、このジョブの作成は作業フローに沿って進みます。各ステップは作業フロ
ーのプロセスとプロセスを実現するのに必要な JobGen Plusで対応する手順を示します。

作業フロー

1. ユーザは情報のタイプを選択します:

(a) 部品番号のみ

(b) 部品番号と数量

 (c) 部品番号とシリアル番号

JobGen Plus
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1. マウスポインタをMenuノードボタンに移動します。

2. マウスポインタが Menu ノード ボタンにある時に左マウスボタンをクリックします。

3. マウスポインタをMenuノードが置かれる場所に移動します。左マウスボタンをダ
ブルクリックします。

4. 新しいMenuノードが作成されます。マウスポインタがMenuノードにある時に左
マウスボタンをダブルクリックします。“Define Menu”ウインドウがスクリーンに現
れます。

ヒントヒントヒントヒント:日本語メニューを作成する場合は、上記の作業をする前に Editメニューから
Define Portableを選択し、Setting > Screen > Large Fontをチェックして下さい。
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5. 以下の情報を入力します:

(a) Basicプロパティで、名前を “mainMenu”に変更します。

(b) Screenプロパティで、ポータブルターミナルのスクリーンに表示する内容をタイ
プします。

(c) Basicプロパティで、Start Nodeオプションをチェックします。

(d) Function Keysプロパティで、 “Exit”をチェックします。”Exit”キー (CMD ->
ESC)が押された場合、mainMenuノードが処理されます。
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6. OKをクリックします。。。。

作業フロー

2. (a)を選択した場合、ステップ 3に進みます。 (b)を選択した場合、ステップ 7に進
みます。(c)を選択した場合、ステップ 13に進みます。

3. 部品番号 (Part Number)情報を収集します。

4. “Exit “ (CMD > ESC)キーが押されたら、ステップ 1に進みます。

5. 部品番号 (Part Number)情報を検証します。入力データが検証をパスしない場合、
ステップ 3に進みます。それ以外は、ステップ 6に進みます。

6. 数量(Quantity)フィールドとシリアル番号(Serial Number)フィールドの両方に”0”を
入れます。次の入力のためにステップ 3に進みます。

JobGen Plus

1. Collect(収集)ノードボタンにマウスポインタを移動することによって、部品番号の
ための収集ノードを作成します。マウスポインタが Collect(収集)ノードボタンにあ
る時に左マウスボタンをクリックします。

2. Collect(収集)ノードが置かれる場所にマウスポインタを移動します。左マウスボタ
ンをダブルクリックします。
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3. 新しい収集(collect)ノードが作成されました。マウスポインタが収集(Collect)ノード
にある時に左マウスボタンをダブルクリックします。 “Define Collect”ウインドウが
スクリーンに現れます。
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4. 以下のオプションを変更します。

(a) Basicプロパティで、名前を “pnOnly”に変更します。

(b) Screenプロパティをクリックします。

(c) スクリーンにプロンプト(入力要求)をタイプします。.

(d) Input > Deviceプロパティをクリックします。
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(e) Keypadと Scannerの両方のオプションが選択していることを確認して下さい。

(f) Verifyプロパティをクリックして下さい。

(g) Length オプションをチェックして、最小値 : 3を Fromに、そして最大値 16を
To:にセットして下さい。

(j) OKをクリックして下さい。
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5. Programノードボタンにマウスポインタを移動して、ポインタが Programノードボ
タンにある間に左マウスボタンをクリックして下さい。

6. Programノードを置く場所にマウスポインタを移動して下さい。左マウスボタンを
ダブルクリックして下さい。

7. 新しく作成した Programノードにマウスポインタがある間に左マウスボタンをダブ
ルクリックして下さい。 “Define Node[Program]”ウインドウがスクリーンに現れま
す。
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8. この Programノードは主にデータフィールドに情報を埋めるためのものです。この
ジョブには pNumber、、、、 quantity(数量)と serial(シリアル)の三つのデータフィールド
があります。 Collectノード pnOnlyは pNumberについての情報を一時的に保存し
ます。 したがって、この Program ノード は pnOnly の情報を pNumber にコピーし、
そして他の二つのフィールドを “0”で埋めます。この Programノードを定義するた
めに、ユーザはノードの名前を “copy_all”に変更する必要があります。そして、以
下の Cソースコードをタイプします:

_copy_all()

{

strcpy(_pNumber,_pnOnly);

_quantity = 0;

strcpy(_serial, “0”);

}

9. これらのノード間のリンクをここで作成する必要があります。マウスポインタを
リンクボタンに移動し、マウスボタンがリンクボタン上にある間に左マウスボタン
をクリックします。

10.マウスポインタを mainMenuノードに移動し、左マウスボタンをクリックしたまま
保持します。マウスポインタを pnOnlyノードに移動し、左マウスボタンを離しま
す。



35

11.マウスポインタが新しく作成したリンクにある間に左マウスボタンをダブルクリッ
クします。 “Define Node”ウインドウがスクリーンに現れます。
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12. Keypad Inputオプションをチェックし、そして Keypad Input オプションの下のス
ペースにマウスポインタがある間に左マウスボタンをクリックして下さい。 “PT-
600 Keypad”ウインドウがスクリーンに現れます。

13. 1ボタンをクリックします。これは”1”を押すと mainMenuノードから pnOnlyノ
ードにプロセスが移動することを示しています。 “PT-600 Keypad”ウインドウを閉
じるために OKボタンをクリックします。

OKをクリックして下さい・

14.マウスポインタを pnOnlyノードに移動して、そして左マウスボタンをクリックし
たままにします。 マウスポインタを copy_allノードに移動し、左マウスボタンを
離します。
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15.新しく作成したリンクにマウスポインタがある間に左マウスボタンをダブルクリッ
クします。 “Define Node”ウインドウがスクリーンに現れます。
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Pass Alwaysオプションは ジョブが pnOnlyノードのプロセスを終えたら、copy-
allノードを処理することを示しています。

16. OKをクリックして下さい。

17.マウスポインタを copy_allノードに移動し、そして左マウスボタンをクリックした
ままにします。マウスポインタを pnOnlyノードに移動し、マウスボタンを離しま
す。
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18.マウスポインタが新しく作成したリンク上にある間に左マウスボタンをダブルクリ
ックします。 “Define Node”ウインドウがスクリーンに現れます。
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Pass Alwaysオプションはジョブが copy_allノードの処理を終えたら、その後
pnOnlyの処理を行うことを示しています。

19. EORオプションをチェックして下さい。

21. Okをクリックしてください。

作業フロー

7. Part Number情報の収集.

8. “Exit”キーが押されたら、ステップ 1へ進む。

9. Part Number 情報の検証。入力データが検証をパスしなかったら、ステップ 7へ進む。
そうでなければ、ステップ 10へ進む。

10. Quantity (数量)情報を収集。

11. Quantity情報を検証。入力データが検証をパスしなかった場合、ステップ 10に進み
ます。そうでなければ、ステップ 12に進みます。

12. Serial Numberフィールドに”0”を入れます。ステップ 7に進みます。

JobGen Plus

1. マウスポインタを Collect Nodeボタンに移動することによって Part Numberについ
ての Collectノードを作ります。マウスポインタが Collectノードボタンにある間に
左マウスボタンをクリックします。

2. Collectノード を置く場所にマウスポインタを移動します。左マウスボタンをダブ
ルクリックします。
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3. 新しい Collectノード が作られました。マウスポインタが Collectノード にある間
に左マウスボタンをダブルクリックして下さい。 “Define Node [Collect]”ウインドウ
がスクリーンに現れます。
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4. 以下のオプションを変更します。

(a) 名前を “pnQty”に変更します。

(b) Screenプロパティをクリックします。

(c) スクリーンのプロンプト(入力要求)をタイプします。

(d) Input > Deviceプロパティをクリックします。
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(e) Keypadと Scannerオプションが選択されていることを確認して下さい。

(f) Verifyプロパティをクリックして下さい。

(g) Lengthオプションをチェックし、最小長 3を Fromに、最大長 16を Toにを入
れて下さい。

(j) OKをクリックして下さい。
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5. Collectノードが置かれる場所にマウスポインタを移動して下さい。左マウスボタン
をダブルクリックして下さい。

6. マウスポインタが Collect Nodeにある間に左マウスボタンをダブルクリックして下
さい。 “Define Node [Collect]”ウインドウがスクリーンに現れます。

7. 以下のオプションを変更します。

(a) 名前を “quantity”に変更します。

(b) Screenプロパティをクリックします。
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(c) プロンプト(入力要求)をタイプします。

(d) Inputプロパティをクリックします。Numerical Integerをチェックします。

(e) Input > Deviceプロパティをクリックします。

(f) Keypadと Scannerオプションの両方が選択されていることを確認して下さい。

(g) Verifyプロパティをクリックして下さい。
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(h) Lengthオプションをチェックして、最少長 1を Fromに、そして最大長 5を To:
に入れます。

(i) Rangeオプションをチェックし、最低限の値: 0を From:に、そして最大の制限値
32000を To:にタイプします。

(k) OKをクリックします。

8. マウスポインタを Programノード ボタンに移動します。ポインタが Programノード
ボタンにある間に左マウスボタンをクリックします。

9. Programノード がおかれる場所にマウスポインタを移動します。左マウスボタンを
ダブルクリックします。
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10.マウスポインタが新しく作成した Programノードにある間に左マウスボタンをダブ
ルクリックします。 “Define Node [Program]”ウインドウがスクリーンに現れます。



48

11.この Programノード は主にデータフィールドに情報を埋めるためのものです。ジョ
ブに、 pNumber、、、、 quantityそして serialの三つのデータフィールドがあります。
二番目の Collectノード: quantityは quantityフィールドの情報を保存します。最初
の Collectノード: pnQtyは pNumberについて情報を一時的に保存します。したが
って、 Programノード は pnQtyから pNumberへ情報をコピーし、そして serialの
フィールドを “0”で埋めます。この Programノードを定義するために、ユーザはノ
ードの名前を “copy_serial”に変更し、そして以下の Cソースコードをタイプして下
さい。

_copy_serial()

{

strcpy(_pNumber,_pnQty);

strcpy(_serial, “0”);

}

12.ここでこれら三つのノード間のリンクを作成する必要があります。マウスポインタ
をリンク ボタンに置いて、マウスポインタがリンク ボタンにある間に左マウスボ
タンをクリックします。

13.マウスポインタを mainMenuノードに移動し、そして左マウスボタンをクリックし
たままにします。マウスポインタを pnQtyノードに移動し、左マウスボタンを離し
ます。
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14.マウスポインタが新しく作成したリンク.にある間に左マウスボタンをダブルクリッ
クします。 “Define Node”ウインドウがスクリーンに現れます。
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15. Key Input オプションをチェックし、マウスポインタを Key Inputの次のスペース
に置いているときに左マウスボタンをクリックします。 “PT-600 Keypad”ウインド
ウがスクリーンに現れます。

16. 2のボタンをクリックします。これは、ユーザが”2”のキーを押した場合、プロセス
は mainMenuノード から pnQtyノードに進むことを示しています。 “PT-600
Keypad”ウインドウを閉じるために OKボタンをクリックして下さい。

17. OKをクリックして下さい。

18.マウスポインタを pnQtyノード に移動し、左マウスボタンをクリックしたままに
します。 マウスポインタを quantity ノード に移動し、左マウスボタンを離します。
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19.マウスポインタが新しく作成したリンク上にある間に左マウスボタンをダブルクリ
ックします。

20. “Define Node”ウインドウがスクリーンに現れます。
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Pass Alwaysオプションは、ジョブが pnQtyノードの処理を終えたら、quantityノ
ードの処理に進むことを示しています。

21. OKをクリックして下さい。

22. マウスポインタを quantityノードに移動し、左マウスボタンをクリックしたまま
にします。マウスポインタを copy_serialノードに移動し、左マウスボタンを離し
ます。

23.マウスポインタが新しく作成したリンク上にある間に左マウスボタンをダブルクリ
ックします。 “Define Node”ウインドウがスクリーンに現れます。
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Pass Alwaysオプションは、ジョブが quantityノードの処理を終了したら、
copy_serialノード の処理を行うことを意味しています。

24. Okをクリックして下さい。

25.マウスポインタを copy_serialノードに移動し、左マウスボタンをクリックしたま
まにします。マウスポインタを pnQtyノードに移動し、左マウスポインタを放しま
す。
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26.新しく作成したリンク上にマウスポインタがある間に左マウスボタンをダブルクリ
ックします。 “Define Node”ウインドウがスクリーンに現れます。
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Pass Alwaysオプションは、ジョブが copy_serialノードの処理を終えたら、 pnQty
ノードの処理を行うことを示しています。

27. EORオプションをチェックして下さい。

27. Okをクリックして下さい。

作業フロー

13. Part Number情報を収集。

14. “Exit”キーが押されたら、ステップ 1へ進みます。

15. Part Number情報を検証。入力データの検証がパスしなかったら、ステップ 13に進
みます。そうでなければ、次のステップに進みます。

16. Serial Numberが連続か、連続でないかを選択します。

17.シリアル番号(Serial Number)が連続の場合、次のステップに進みます。そうでなけ
ればステップ 25に進みます。

18.最初の Serial Numberを収集します。

19. Serial Number情報を検証します。入力データが検証をパスしなかった場合、ステッ
プ 18に進みます。そうでなければ次のステップに進みます。.

20.連続した項目の番号を収集します。

21.番号を検証します。入力データが検証をパスしなかった場合、ステップ 20に進みま
す。そうでなければ、次のステップに進みます。

22.カウンタをゼロにセットします。

23. Quantityフィールドに”1”を入れ、データファイルに連続する Serial Numberを加えま
す。

24.カウンタに 1を加えます。カウンタが連続する項目の番号に等しい場合、ステップ
13に進みます。そうでなければステップ 23に進みます。

25. Serial Numberを収集します。

26. Serial Number情報を検証します。入力データが検証をパスしない場合、ステップ 25
に進みます。そうでなければ、次のステップに進みます。

27. Quantityフィールドに”1”を入れます。ステップ 13に進みます。

JobGen Plus

1. マウスポインタを Collectノードボタンに移動することによって Part Numberについ
ての収集ノードを作成します。マウスポインタが Collectノードボタンにある間に
左マウスボタンをクリックします。
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2. Collectノードが置かれる場所にマウスポインタを移動します。左マウスボタンをダ
ブルクリックします。

3. 新しい Collectノード が作成されました。マウスポインタが Collectノードにある間
に、左マウスボタンをダブルクリックします。 “Define Node [Collect]”ウインドウ
がスクリーンに現れます。
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4. 以下のオプションを変更します:

(a) ノード名を “pNumber”に変更します。

(b) Screenプロパティをクリックします。

(c) プロンプト(入力要求)をタイプします。

(d) Input > Deviceプロパティをクリックします。
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(e) Keypadと Scannerオプションの両方が選択されていることを確認して下さい。

(f) Inputプロパティをクリックし、Set Data As Last Record, And Complete Input
オプションをチェックします。

(g) Verifyプロパティをクリックします。

(h) Lengthオプションをチェックし、最小値 3を From:に、最大値 16を To:に入れ
ます。



59

(k) OKをクリックします。

5. Menuノードボタンをクリックします。

6. マウスポインタをMenuノードが置かれる場所に移動します。左マウスボタンをダ
ブルクリックします。

7. 新しいMenuノードが作成されました。マウスポインタがMenuノードにある間に
左マウスボタンをダブルクリックして下さい。 “Define Node[Menu]”ウインドウが
スクリーンに現れます。
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8. 以下の情報を入力します:

(a) 名前を “choice”に変更します。

(b) ポータブル・ターミナルのスクリーンに表示する内容をタイプします。

9. OKをクリックします。
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10.マウスポインタを Collectノードボタンに移動することによってシリアル番号につ
いての収集ノード を作成します。 マウスポインタが Collectノードボタンにある
間に左マウスボタンをクリックします。

11. Collectノードを置く場所にマウスポインタを移動します。左マウスボタンをダブル
クリックします。

12.新しい収集ノード(Collectノード)が作成されました。マウスポインタが収集ノード
(Collectノード)にある間に左マウスボタンをダブルクリックします。 “Define Node
[Collect] “ウインドウがスクリーンに現れます。
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以下のオプションをチェックします:

(a) ノードの名前を “serial”に変更します。

(b) Screenプロパティをクリックします。

(c) プロンプト(入力要求)をタイプします。

(e) OKをクリックします。
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Programノード ボタンにマウスカーソルを移動します。Programノードボタンにポ
インタがある間に左マウスボタンをクリックします。

13. Programノードを置く場所にマウスポインタを移動します。左マウスボタンをダブ
ルクリックします。

14.新しく作成したプログラムノード( Programノード)にマウスポインタがある間に左
マウスボタンをダブルクリックします。 “Define Node [Program]”ウインドウがスク
リーンに現れます。
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15.この Programノードは主に quantityフィールドに情報を埋めます。 pNumberフィ
ールドと serialフィールドにデータを入れたら、この Programノードは quantityフ
ィールドに”1”を入れます。この Programノードを定義するには、ユーザはノード
名を “copy_qty”に変更し、以下の Cソースコードをタイプする必要があります。

_copy_qty()

{

strcpy(tempstr, _pNumber);

strcat(tempstr,”,”);

strcat(tempstr,”1”);

strcat(tempstr,”,”);

strcat(tempstr,_serial);

AppendRecord(NULL,tempstr);

}

16. OKをクリックして下さい。

17.マウスポインタを Collectノードボタンに移動します。マウスポインタが Collectノ
ードボタンにある間に左マウスボタンをクリックします。

18. Collectノードを置く場所にマウスポインタを移動します。左マウスボタンをダブル
クリックします。
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19.新しい Collectノードが作成されました。マウスポインタが Collectノードにある間
に左マウスボタンをダブルクリックします。 “Define Node [Collect]”ウインドウが
スクリーンに現れます。
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20.以下のオプションを変更します。

(a) ノード名を “startSN”に変更します。

(b) Screenプロパティをクリックします。

(c) プロンプト(入力要求)をタイプします。

(d) Input > Deviceプロパティをクリックします。
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(e) Keypadと Scannerオプションの両方が選択されていることを確認して下さい。

(f) Verifyプロパティをクリックして下さい。

(g) Lengthオプションをチェックして、最小値 1を From:に、そして最大値 32を
To:に入れます。

(h) OKをクリックします。

21.マウスポインタを Collectノードが置かれる場所に移動します。左マウスボタンを
ダブルクリックします。
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22.マウスポインタが Collectノードにある間に左マウスボタンをダブルクリックしま
す。 “Define Node [Collect]”ウインドウがスクリーンに現れます。

23.以下のオプションを変更します。
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(a) ノード名を “counter”に変更します。

(b) Screenプロパティをクリックします。

(c) プロンプト(入力要求)をタイプします。

(d) Inputプロパティをクリックします。Numerical Integerをチェックします。

(e) Input > Deviceプロパティをクリックします。
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(f) Keypadオプションをチェックします。

(g) Verifyプロパティをクリックします。

Lengthオプションをチェックし、最小値 1を From:に、最大値 2を To:に入れま
す。

(h) Rangeオプションをチェックし、Fromを 0、To:を 30とします。
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(k) OKをクリックします。

26.マウスポインタを Programノードボタンに移動します。ポインタが Programノード
ボタンにある間に左マウスボタンをクリックします。

27. Programノードが置かれる場所にマウスポインタを移動します。左マウスボタンを
ダブルクリックします。

28. 新しく作成した Programノードにマウスポインタがある間に左マウスボタンをダブ
ルクリックします。 “Define Node [Program]”ウインドウがスクリーンに現れます。
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29.この Programノードは主にデータフィールドに情報を埋めます。ユーザははじめの
Serial Numberと保存する Serial Numbers数を入力する必要があります。この
Program ノードは quantityフィールドに”1”を入れ、そして生成した連続するシリ
アル番号を serialフィールドに入れます。この Programノードを定義するには、ユ
ーザはノード名を “add_sn”に変更し、以下の Cソースコードをタイプします。

_add_sn()

{

long int temp;

int i;

clear_screen();

temp = atol(_startSN);

for (i=0;i<_counter;i++)

{

printf(“%ld\n”,temp);

_ltoa(temp,str,10);

strcpy(tempstr,_pNumber);

strcat(tempstr, “,”);

strcat(tempstr, “1”);

strcat(tempstr, “,”);

strcat(tempstr, str);
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AppendRecord(NULL,tempstr);

temp++;

}

}

30. OKをクリックします。

31.これらの三つのノード間にリンクを作成する必要があります。マウスポインタを
リンクボタンに移動し、マウスポインタがリンクボタンにある間に左マウスボタン
をダブルクリックします。

32.マウスポインタを mainMenuノードへ移動し、左マウスボタンをクリックしたまま
にします。マウスポインタを pNumberノードへ移動し、左マウスボタンを離しま
す。

33.マウスポインタが新しく作成したリンク上にある間に左マウスボタンをダブルクリ
ックします。 “Define Node”ウインドウがスクリーンに現れます。
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34. Key Pad Inputオプションをチェックし、Key Pad Inputオプションの次のスペース
上にマウスポインタがある間に左マウスボタンをクリックします。 “PT-600
Keypad”ウインドウがスクリーンに現れます。

35. 3のボタンをクリックします。これは、ユーザが”3”のキーを押した場合、プロセ
スが mainMenuノードから pNumberノードに進むことを意味します。 “PT600
Keypad”ウインドウを閉じるために OKボタンを押します。

36. OKをクリックします。
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37.マウスポインタを pNumberノードに移動し、左マウスボタンをクリックしたまま
にします。マウスポインタを choiceノードに移動し、左マウスボタンを離します。

38.新しく作成したリンク上にマウスポインタがある間に左マウスボタンをダブルクリ
ックします。“Define Node”ウインドウがスクリーンに現れます。
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Pass Alwaysオプションはジョブが pNumberノードの処理を終えたら、 choiceノ
ードを処理することを示しています。

39. OKをクリックします。

40. マウスポインタを choice ノード に移動し、左マウスボタンを押したままにします。
マウスポインタを serialノードに移動し、左マウスボタンを離します。
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41.マウスポインタが新しく作成したリンク上にある間に左マウスボタン間をダブルク
リックします。 “Define Node”ウインドウがスクリーンに現れます。
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42. Key Pad Input オプションをチェックし、そしてマウスポインタが Key Pad Input
オプションの次のスペース上にある時に左マウスボタンをクリックします。 “PT-
600 Keypad”ウインドウがスクリーンに現れます。

43. 2のボタンをクリックします。これは”2”キーが押された場合、プロセスは choice
ノードから serialノードに移動することを示しています。 “PT-600 Keypad”ウイ
ンドウを閉じるために OKをクリックします。

44. Okをクリックします。

45.マウスポインタを serialノードに移動し、左マウスボタンをクリックしたままにし
ます。マウスポインタを copy_qtyノードに移動し、左マウスボタンを離します。
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46.新しく作成したリンク上にマウスポインタがある間に左マウスボタンをダブルクリ
ックします。 “Define Node”ウインドウがスクリーンに現れます。
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Pass Alwaysオプションは、ジョブが serialノードの処理を終えたら、 copy_qtyノ
ードの処理を行うことを示しています。

47. OKをクリックします。

48.マウスポインタを copy_qtyノードに移動し、左マウスボタンをクリックしたまま
にします。マウスポインタを serialノードに移動し、左マウスボタンを離します。

49.新しく作成したリンク上にマウスポインタがある間に左マウスボタンをダブルクリ
ックします。 “Define Node”ウインドウがスクリーンに現れます。
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Pass Alwaysオプションは、ジョブが copy_qtyノードの処理を終えたら、 serial
ノードの処理を行うことを示しています。

50. EORオプションをチェックします。

51. Okをクリックします。

52.マウスポインタを serialノード に移動し、左マウスボタンをクリックしたままにし
ます。マウスポインタを pNumberノードに移動して左マウスボタンを離します。
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53.マウスポインタが新しく作成したリンク上にある間に、左マウスボタンをダブルク
リックします。 “Define Node”ウインドウがスクリーンに現れます。
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54. RRLI, Reset “Repeat Last Input” For All Nodesオプションをチェックします。この
オプションは、pNumberノードに新しいデータを入力する場合に必要です。
Keypad Inputオプションをチェックし、そしてマウスポインタが Keypad Input オ
プションの次のスペースにある間に左マウスボタンをクリックします。 “PT-600
Keypad”ウインドウがスクリーンに現れます。

55. F4ボタンをクリックします。これはユーザが”F4”キーを押した場合に、プロセスは
serialノードから pNumberノードに移動することを示します。 “PT-600 Keypad”ウ
インドウを閉じるために OKボタンをクリックします。

56. OKをクリックします。

57.マウスポインタを choiceノードへ移動し、左マウスボタンをクリックしたままにし
ます。マウスポインタを startSNノードへ移動し、左マウスボタンを離します。
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58.新しく作成したリンクにマウスポインタがある間に左マウスボタンをダブルクリッ
クします。 “Define Node”ウインドウがスクリーンに現れます。

59. Keypad Input オプションをチェックし、Keypad Input オプションの次のスペース
にマウスポインタがある間に左マウスボタンをクリックします。 “PT-600 Keypad”
ウインドウがスクリーンに現れます。.
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60. 1のボタンをクリックします。これはユーザが”1”のキーを押したら、プロセスはユ
ーザが”1”のキーを押した場合、プロセスは choiceノード から startSNノードへ移
動することを示しています。 “PT-600 Keypad”ウインドウを閉じるために OKボタ
ンをクリックして下さい。

61. OKをクリックして下さい。

62.マウスポインタを startSNノードに移動し、左マウスボタンをクリックします。
マウスポインタを counterノードに移動し、左マウスボタンを離します。
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63.マウスポインタか゛新しく作成したリンク上にある間に左マウスボタンをダブルク
リックします。 “Define Node”ウインドウがスクリーンに現れます。



87

Pass Alwaysオプションはジョブが startSNノードの処理を完了したら、 counter
ノードの処理に進むことを示しています。

64. Okをクリックして下さい。

65.マウスポインタを counterノードに移動し、左マウスボタンをクリックしたままに
します。マウスポインタを add_snノードに移動し、左マウスボタンを離します。

66.マウスポインタが新しく作成したリンク上にある間に左マウスボタンをダブルクリ
ックします。“Define Node”ウインドウがスクリーンに現れます。
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Pass Alwaysオプションはジョブが counterノードの処理を終えたら add_snノード
の処理に進むことを示しています。

67. Okをクリックします。

68.マウスカーソルを add_snノードに移動し、マウスボタンをクリックしたままにし
ます。マウスポインタを pNumberノードに移動し、左マウスボタンを離します。
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69.新しく作成したリンク上にマウスポインタがある間に左マウスボタンをダブルクリ
ックします。“Define Node”ウインドウがスクリーンに現れます。
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Pass Alwaysオプションはジョブが the add_snノードの処理を終えたら pNumber
ノードの処理に進むことを示しています。

70. RRLIオプションをチェックします。

71.マウスポインタを Programノードボタンに移動します。ポインタが Programノード
ボタンにある間に左マウスボタンをクリックします。適当な場所にマウスポインタ
を移動します。左マウスボタンをダブルクリックします。Programノードが作られ
ます。

Programノードを左マウスボタンでダブルクリックします。Basicをクリックし、名
前を Globalに変更します。Global Accessをチェックします。

(a) Programをクリックします。

(b) “Define Node [Program] - Global”がスクリーンに現れます。

(c) 右のスペースの中にグローバル変数を指定します。

char tempstr[60];

char str[10];

72. Okをクリックし、 invent.joとしてジョブを保存します。.

73.ジョブを保存した後で、マウスポインタをツールバーの Simulate JobまたはMake
Jobボタンに移動します。この在庫管理のジョブをコンパイルするために左マウス
ボタンをクリックします。実行可能なファイルを作るプロセスが始まります。
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EXEファィルができた後で、JobGen PlusはMake Jobあるいは Simulate Jobオプ
ションのいずれを選択したかによって、ファイルをポータブル・ターミナルにダウ
ンロードするか、あるいは PCのスクリーンに結果を表示するためにシミュレーシ
ョンを行います。


